
Manual de instrucciones



INSTRUCCIONES  DE  SEGURIDAD  
IMPORTANTES

A la hora de deshacerse de este aparato, no lo elimine junto con la basura orgánica. Existe un
procedimiento de eliminación de aparatos electrónicos usados que cumple con la legislación
actual sobre tratamiento, recuperación y reciclaje de elementos electrónicos.

Todos los usuarios no profesionales y que sean ciudadanos de uno de los 25 países miembros de la EU, Suiza 
y Noruega, pueden devolver sus aparatos electrónicos usados, sin coste alguno, al comercio en el que fueron 
adquiridos (si adquiere allí otro aparato similar) o en determinados puntos limpios designados

En el caso de cualquier otro país distinto a los anteriores, póngase en contacto con las autoridades locales para que 
le informen del método adecuado para deshacerse de este aparato. El hacer lo anterior le asegurará que este aparato 
sea eliminado siguiendo las normas actuales de tratamiento, recuperación y reciclaje de materiales, evitando los 
posibles efectos negativos para el medio ambiente y la salud.

POR SU PROPIA SEGURIDAD
LEA ESTAS INSTRUCCIONES

CONSERVE ESTAS INSTRUCCIONES

PRESTE ATENCION A TODAS LAS ADVERTENCIAS

CUMPLA CON LO INDICADO EN ESTAS INSTRUCCIONES

NO PERMITA QUE ESTE APARATO QUEDE EXPUESTO A LA LLUVIA O A SALPICADURAS Y 
NO COLOQUE NINGUN OBJETO QUE CONTENGA LIQUIDOS (COMO UN JARRON) SOBRE EL.

LIMPIE ESTE APARATO SOLO CON UN TRAPO SUAVE Y SECO.

NO BLOQUEE NINGUNA DE LAS ABERTURAS DE VENTILACION E INSTALE ESTE APARATO 
DE ACUERDO A LAS INSTRUCCIONES DEL FABRICANTE. NO INSTALE ESTE APARATO 
CERCA DE FUENTES DE CALOR COMO RADIADORES, CALENTADORES, HORNOS U OTROS 
APARATOS (INCLUYENDO AMPLIFICADORES) QUE PRODUZCAN CALOR. 

UTILICE SOLO ACCESORIOS/COMPLEMENTOS ESPECIFICADOS POR EL FABRICANTE.

DESENCHUFE ESTE APARATO DE LA CORRIENTE DURANTE LAS TORMENTAS ELECTRICAS 
O CUANDO NO LO VAYA A USAR DURANTE UN PERIODO DE TIEMPO LARGO.

No anule el sistema de seguridad de un conector polarizado o con toma de tierra. 
Un conector polarizado tiene dos bornes de distinta anchura. Uno con toma de 
tierra tiene dos bornes iguales y una tercera lámina para la conexión a tierra. 
El borne ancho o la tercera lámina se incluyen para su seguridad. Si el conector 
incluido no encaja en su salida de corriente, haga que un electricista sustituya
su salida de corriente anticuada.

Coloque el cable de alimentación de forma que no quede aplastado ni retorcido, 
especialmente en los enchufes, conectores y en el punto en el que salen del aparato.

Consulte cualquier avería con el servicio técnico oficial. Este aparato deberá ser 
reparado cuando haya resultado dañado de cualquier forma, como por ejemplo si 
el cable de alimentación o el enchufe están dañados, si se ha derramado un líquido 
o se ha introducido un objeto dentro del aparato, si ha quedado expuesto a la lluvia 
o la humedad, si no funciona normalmente o si ha caído al suelo.

DESCONEXION DE LA CORRIENTE: Coloque este aparato de forma que pueda acceder 
fácilmente al cable de alimentación. Cuando lo vaya a instalar en un rack o en un 
montaje en el que no pueda acceder al enchufe, utilice una regleta con interruptor 
con una separación entre los contactos de al menos 3 mm en cada polo.



INSTRUCCIONES  DE  SEGURIDAD  
IMPORTANTES

DECLARACION DE CONFORMIDAD
Nombre del fabricante:	 Lexicon
Dirección del fabricante:	 8760 S. Sandy Parkway 				  
			   Sandy, Utah 84070, USA
declara que el producto:
Nombre del producto:			   Onix U42S 
Opciones del producto:		 �todas (requiere un adaptador de corriente de clase II que cumpla 

con los requisitos de EN60065, EN60742 o equivalentes).

cumple con las siguientes especificaciones de producto:

	 Seguridad:		 IEC 60065 (7ª edición 2001)
	 EMC:		  EN 55013 (2001 + A1)
			   EN 55020 (1998)

Información complementaria:
El producto citado aquí cumple con los requisitos de la Directiva de bajo voltaje 2006/95/EC y 
con la Directiva EMC 2004/108/EC.
			    
			   �Vicepresidente técnico		
			   8760 S. Sandy Parkway			 
			   Sandy, Utah 84070, USA
			   Fecha: 2 de diciembre de 2008

Contacto en Europa:		  Su distribuidor o servicio técnico DigiTech o
			   Harman Music Group
			   8760 South Sandy Parkway
			   Sandy, Utah  84070  USA
			   	 Fax: (801) 566-7005

ELECTROMAGNETIC
COMPATIBILITY 

This unit conforms to the Product Specifications noted 
on the Declaration of Conformity. Operation is 
subject to the following two conditions: 

•	� this device may not cause harmful 
interference, and 

•	� this device must accept any interference received, 
including interference that may cause undesired 
operation.  

Operation of this unit within significant 
electromagnetic fields should be avoided.

•	 use only shielded interconnecting cables.



Garantía

En Lexicon® Professional estamos orgullosos de todos nuestros productos, y por este 
motivo dotamos a cada uno de ellos de la siguiente garantía:

1. 	 Para que esta garantía entre en vigor, debe remitirnos debidamente 
cumplimentada la tarjeta de garantía en los 10 días siguientes a la fecha de compra.

2. 	 Lexicon® Professional garantiza que este producto, siempre y cuando sea usado 
dentro del territorio de los Estados Unidos, está libre de defectos en materiales y mano de 
obra bajo condiciones normales de uso y mantenimiento.

3. 	 La responsabilidad de Lexicon® Professional por esta garantía queda 
limitada a la reparación o sustitución de las piezas defectuosas que den muestras 
de avería, suponiendo que el aparato sea devuelto a Lexicon® Professional con una 
AUTORIZACION DE DEVOLUCION, en cuyo caso todas las piezas y mano 
de obra quedarán cubiertas por un periodo de un año. Póngase en contacto con 
nosotros por teléfono para que le facilitemos el número de autorización de devolución 
necesario. La empresa no será responsable de los daños que se puedan ocasionar por el 
uso de este aparato en ningún tipo de circuito o sistema.

4. 	 La prueba de compra se considera responsabilidad del comprador.

5. 	 Lexicon® Professional se reserva el derecho a realizar modificaciones en el diseño o 
a hacer cualquier tipo de adición o mejora en este producto sin que ello conlleve la obligación 
de realizar esos mismos cambios en las unidades ya fabricadas.

6. 	 Cualquier apertura no autorizada o modificación de este aparato por cualquier 
persona distinta a un técnico autorizado por Lexicon® Professional o el uso de este 
aparato con voltajes de corriente que estén fuera de lo indicado por el fabricante 
invalida cualquier derecho del usuario relativo a esta garantía.

7. 	 Lo expresado en los párrafos anteriores sustituye a cualquier otra garantía, 
expresa o implícita, y Lexicon® Professional ni asume ni autoriza a que ninguna 
persona asuma ningún tipo de obligación o responsabilidad relacionada con la venta 
de este aparato. Bajo ningún concepto Lexicon® Professional o sus distribuidores serán 
responsables por daños especiales, lucro cesante, daño emergente, daños y perjuicios o 
cualquier tipo de retraso en la ejecución de esta garantía debido a causas que queden 
fuera de nuestro control.

NOTA: La información contenida en este manual está sujeta a cambios sin previo aviso. 
Es posible que parte de la información contenida en este manual no sea exacta, a causa 
de modificaciones no documentadas tanto en este aparato como en su sistema operativo 
desde el momento de finalizar esta versión del manual. Toda la información contenida 
en esta versión del manual de instrucciones anula la de cualquier versión anterior.
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Introducción
¡Enhorabuena por la compra de su interface de grabación de sobremesa 
Lexicon® I-ONIX U42S! 

El diseño I·ONIX U42S (pendiente de patente) se adapta a la perfección 
al sitio más lógico entre su teclado y monitor. Con todos los controles 
de nivel de entrada y de monitor a su alcance, se preguntará por qué a 
nadie se le había ocurrido nada similar antes. 
 
Con previos dbx® de nuevo diseño en cada canal, el I·ONIX U42S está 
sobradamente equipado para ofrecerle grabaciones profesionales. 
Estos previos funcionan con una fuente de alimentación de alto voltaje 
para garantizar su estabilidad y le ofrecen grabaciones de alta calidad 
a lo largo de un amplio rango dinámico. Los conversores A/D - D/A le 
aseguran un sonido limpio a 24 bits/96 kHz para poder captar hasta el 
detalle más sutil de su actuación.

El nombre de Lexicon es sinónimo de “la mejor reverberación del mundo.” 
El plug-in de reverb Pantheon™ II VST/AU dispone de 6 tipos de reverb con 
16 parámetros ajustables y 35 presets de fábrica que van desde efectos 
vocales a efectos especiales pasando por sonido directo. Es fácil completar 
su mezcla y hacer que su música suene extraordinariamente con las 
excelentes reverbs que han hecho famoso a Lexicon.

Características
Conexión USB 2.0 a DAW - hasta a 480 Mbps•	
Velocidades de muestreo de 44.1 a 96 kHz, con una resolución de 24 bits•	
Tomas combo analógicas de 6,3 mm y XLR en el panel trasero para •	
entradas de micro/línea

Salidas analógicas TRS de 6,3 mm (principal stereo)•	
Previos de micro de bajo nivel de ruidos y alto voltaje de dbx•	 ® en 
todas las entradas analógicas de micro/línea

Compatible con Windows® y Mac®•	
Alimentación fantasma de 48 V en cada par de entradas•	
Medición de señal de entrada mediante 8 LEDs por canal•	
Medición de señal de bus stereo y mezcla de señal•	
Conexiones de 6,3 mm de alto nivel para auriculares•	
Entrada/salida MIDI •	
Monitorización de latencia cero•	
Drivers ASIO de baja latencia•	
Plug-in de reverb Lexicon Pantheon II VST/AU•	
Paquete de software que incluye el Cubase•	 ® LE 4 de Steinberg® y el 
Toontrack® EZdrummer® Lite
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Desembalaje de su interface de grabación de 
sobremesa I-ONIX U42S
Dentro de la caja del interface de grabación de sobremesa I-ONIX U42S 
encontrará la propia unidad U42S y un DVD con software para Windows® 
y Macintosh®. Conserve el embalaje por si en algún momento debe 
transportar la unidad. Inspeccione el I-ONIX U42S y su embalaje en 
busca de posibles daños. Si detecta daños producidos durante el transporte, 
comuníqueselo al transportista o a su distribuidor.

ELEMENTOS incluidos:
U42S•	
DVD instalador con drivers, plug-in de reverb Lexicon Pantheon II, •	
software de grabación Cubase LE 4 y ToonTrack® EZ Drummer Lite 
para Mac® y Windows® 
Cable USB•	
Tarjeta de garantía Lexicon Professional•	

NOTA: En el DVD de software viene incluido el manual completo del  
Cubase LE 4.

Requisitos del sistema
El potente software de grabación de sonido requiere un ordenador 
igualmente potente que disponga del sistema operativo, procesador y 
memoria adecuados. La mayoría de los ordenadores actuales ya cumplen 
estos requisitos, o pueden actualizarse para ser compatibles con el I-ONIX 
U42S. El disponer de más memoria RAM de la mínima necesaria le permite 
realizar más procesado y mejora el rendimiento.   

Windows® Vista, XP 
Sistema multinúcleo•	
1 GB RAM (recomendado)•	
Pantalla con una resolución mínima de 1024 x 768 pixels•	
Unidad DVD-ROM•	
Acceso a internet para activación de la licencia de software•	

Mac®

Sistema Intel•	 ® multinúcleo
1 GB RAM (recomendado)•	
Sistema operativo OS X 10.4.9 o posterior•	
Pantalla con una resolución mínima de 1024 x 768 pixels•	
Unidad DVD-ROM•	
Acceso a internet para activación de la licencia de software•	

Nota: Para poder visualizar los documentos en formato pdf del DVD se 
necesita tener instalado el Adobe Reader.
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Panel frontal
1 2

3 4 5 6 7 8 9 10 11 12 13 14 15 16 17

1. leds DE NIVEL DE ENTRADA
Le indican el nivel de señal para cada entrada mostrándole el margen o  
headroom que le queda antes de la saturación. Sus valores son:
Rojo		  Saturación
Amarillo	 –3 dB
Verde		  –6 dB
Verde		  –9 dB
Verde		  –12 dB
Verde		  –18 dB
Verde		  –24 dB
Verde		  –36 dB

2. leds DE NIVEL DE SALIDA
Le indican el nivel de señal para cada salida mostrándole el margen o  
headroom que le queda antes de la saturación. Sus valores son:
Rojo		  Saturación
Amarillo	 –3 dB
Verde		  –6 dB
Verde		  –9 dB
Verde		  –12 dB
Verde		  –18 dB
Verde		  –24 dB
Verde		  –36 dB

3. MANDOS DE NIVEL Phones 1 Y Phones 2
Le permiten ajustar el nivel de salida de auriculares. El mando Phones 1 
controla el nivel de la salida Phones 1 y el mando Phones 2 el de la salida 
Phones 2.

4. MANDO de ganancia MIc/Line/Inst 1
Ajusta la ganancia de entrada para la toma Mic/Line 1 o Instrument 1. 

5. LED Instrument 1
Se enciende en cuanto introduzca un conector de 6,3 mm en la toma 
Instrument 1 del panel lateral derecho.
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6. BOTON Y LED Stereo - Mic/Line/Inst 1 Y Mic/Line/inst 2
Este botón le permite cambiar entre el modo stereo y el mono para la entrada 
Mic/Line 1 (o Instrument 1) y Mic/Line 2 (o Instrument 2). El LED estará 
encendido en rojo cuando esté activado el modo stereo. 
 
En el  modo stereo (LED Stereo encendido), las señales de la entrada 
Instrument 1 y Mic/Line 1 son enviadas a la salida principal izquierda, 
mientras que las señales de la entrada Instrument 2 y Mic/Line 2 se 
envían a la salida principal derecha.  
 
En el modo mono (LED Stereo apagado), cada par de señales de entrada 
son mezcladas y enviadas a las salidas principales izquierda y derecha 
como una señal mono. Cada par incluye la señal Instrument 1 o Mic/
Line 1 y la señal Instrument 2 o Mic Line 2.

7. LED 48V 
Se enciende cuando está activada la alimentación fantasma para el par 
de entradas Mic/Line 1 y 2. Puede activar la alimentación fantasma  de 
cualquier toma combo de entrada utilizando los botones 48V del panel 
trasero. Los micros dinámicos no necesitan electricidad para funcionar, 
si bien ésta tampoco los daña. Sin embargo, la mayoría de los micros 
condensadores sí que la requieren. Si no está seguro de si su micro necesita o 
no alimentación fantasma, consulte la documentación de su micro o contacte 
con su fabricante. 

8. LED Instrument 2
Se enciende en cuanto introduzca un conector de 6,3 mm en la toma 
Instrument 2 del panel lateral derecho.

9. MANDO DE GANANCIA MIc/Line/Inst 2
Le permite ajustar el nivel de ganancia de entrada para la toma Mic/Line 2 o 
Instrument 2. 

10. MANDO DE GANANCIA MIc/Line 3
Le permite ajustar el nivel de ganancia de entrada para la toma Mic/Line 3. 

11. BOTON Y LED Stereo Mic/line 3 Y mic/line 4
Este botón le permite cambiar entre el modo stereo y el mono para la entrada 
Mic/Line 1 (o Instrument 1) y Mic/Line 2 (o Instrument 2). El LED estará 
encendido en rojo cuando esté activado el modo stereo. 
 
En el  modo stereo (LED Stereo encendido), la señal de la entrada Mic/
Line 3 es enviada a la salida principal izquierda, mientras que la de la 
entrada Mic/Line 4 es enviada a la salida principal derecha.  
 
En el modo mono (LED Stereo apagado), cada par de señales de entrada 
son mezcladas y enviadas a las salidas principales izquierda y derecha 
como una señal mono. Cada par incluye la señal Mic/Line 3 y la señal 
Mic/Line 4.

12. LED 48V
Se enciende cuando está activada la alimentación fantasma para el par 
de entradas Mic/Line 3 y 4. Puede activar la alimentación fantasma  de 
cualquier toma combo de entrada utilizando los botones 48V del panel 
trasero. Los micros dinámicos no necesitan electricidad para funcionar, 
si bien ésta tampoco los daña. Sin embargo, la mayoría de los micros 
condensadores sí que la requieren. Si no está seguro de si su micro necesita o 
no alimentación fantasma, consulte la documentación de su micro o contacte 
con su fabricante. 
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13. MANDO de ganancia MIc/Line 4 
Ajusta el nivel de ganancia de entrada para Mic/Line 4. 

14. MANDO Output Level
Le permite ajustar el nivel de la salida principal izquierda y derecha.

15. LED S/PDIF
Se enciende en cuanto sea detectada una conexión S/PDIF. Tenga en cuenta 
que solo puede realizar una conexión S/PDIF cuando haya establecido una 
conexión USB.

16. MANDO Monitor Mix
El I-ONIX U42S le permite escuchar directamente y de forma inmediata 
sus señales de entrada analógicas mientras las graba sin tener que ajustar los 
niveles en el programa y antes del retardo producido por los convertidores 
digitales y la latencia de grabación del ordenador. Esta monitorización 
analógica de latencia cero es controlada por el mando Monitor Mix, que 
puede utilizar para ajustar la mezcla entre las entradas analógicas de directo y 
los sonidos procedentes del ordenador vía USB (“reproducción”). Para ajustar 
la mezcla de reproducción del ordenador (pistas previas, retornos de efectos, 
etc.), utilice los faders de la pantalla de mezcla del programa. Para escuchar 
solo las señales de entrada de la fuente de directo conectada al U42S, 
gire el mando Mix totalmente hacia la izquierda hasta la posición Direct. 
Para escuchar solo la mezcla procedente del ordenador, gire este mando 
totalmente hacia la derecha hasta la posición Playback. Cualquier señal de la 
entrada S/PDIF es convertida a analógica y enviada al control de mezcla para 
que pueda monitorizar directamente esta entrada como si fuera una entrada 
analógica. La salida del control Monitor Mix es rutada a las salidas de línea y 
de auriculares. 

17. LED USB
Se enciende en cuanto sea detectada una conexión USB.
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Paneles lateral y trasero

1 2 3 4 5 6 7 8 9 10

1. ENTRADAS Instrument 1 E instrument 2
Estas entradas no balanceadas aceptan conectores de 6,3 mm y admiten 
fuentes de nivel de instrumento (incluyendo guitarras). Tenga en cuenta que 
cuando tenga algo conectado a Instrument 1, la entrada Mic/Line estará 
desactivada. Esto mismo es también aplicable a las entradas Instrument 2 y 
Mic/Line 2: cuando esté utilizando la entrada Instrument 2, la entrada Mic/
Line estará desactivada.

2.  TOMA Power
Conecte aquí solo la fuente de alimentación PSS3-xxx incluida (donde 
"xxx" indica el voltaje correspondiente).

3. PUERTO USB
Sirve para conectar el U42S a su ordenador. Viene también incluido un cable 
standard USB. El U42S es solo compatible con USB 2.0.

4.  MIDI IN Y OUT
Son tomas MIDI de entrada y salida a y de su ordenador.  Conecte aquí sus 
teclados MIDI, módulos de sonido y controladores externos.

5.  S/PDIF In Y Out
Los puertos S/PDIF de entrada y salida son conectores phono (RCA) no 
balanceados que transmiten y reciben un flujo audio de 2 canales a 16 ó 24 bits. 
Puede encontrar puertos S/PDIF en muchas grabadoras de audio digitales y 
de CDs profesionales y no profesionales. Le recomendamos que utilice cable 
coaxiales de 75 Ohmios para la transferencia S/PDIF y que el cable no tenga 
más de 10 metros de longitud para minimizar las interferencias y cortes de 
datos.  

6.  Main Outputs (sALIDAS PRINCIPALES)
Estas salidas admiten conectores de 6,3 mm TRS balanceados o TS no 
balanceados. Puede conectarlas a una mesa de mezclas, etapa de potencia, 
monitores de estudio amplificados, grabadoras u otras entradas de nivel de 
línea. Para conseguir los mejores resultados, utilice cables balanceados para 
estas conexiones.

7.  ENTRADAS Mic/Line 1–4
Estas entradas balanceadas aceptan conectores XLR o de 6,3 mm y admiten 
fuentes de nivel de línea y micro. Tenga en cuenta que cuando tenga algo 
conectado a la entrada Instrument 1, la entrada Mic/Line estará desactivada. 
Esto mismo es también aplicable a las entradas Instrument 2 y Mic/Line 2.



7 

8. BOTON DE ALIMENTACION FANTASMA DE 48V - Mic/Line 1 Y Mic/
Line 2
Activa la alimentación fantasma en las entradas Mic/Line 1 y Mic/Line 2. 
Cuando esté activada, se iluminará el LED +48V que está entre los mandos 
de ganancia Mic/Line/Inst 1 y 2 del panel frontal. Los micros dinámicos 
no necesitan electricidad para funcionar, pero ésta tampoco los daña. Sin 
embargo, la mayoría de los micros condensadores sí que la requieren. Si no 
está seguro de si su micro necesita o no alimentación fantasma, consulte la 
documentación de su micro o contacte con su fabricante. Este debe estar en 
OFF si conecta fuentes de nivel de línea a las entradas Mic In.

9. BOTON DE ALIMENTACION FANTASMA DE 48V- Mic/Line 3 Y Mic/
Line 4
Activa la alimentación fantasma en las entradas Mic/Line 3 y Mic/Line 4. 
Cuando esté activada, el LED +48V LED entre los mandos de ganancia 
Mic/Line/Inst 3 y 4 del panel frontal . Los micros dinámicos no necesitan 
electricidad para funcionar, pero ésta tampoco los daña. Sin embargo, la 
mayoría de los micros condensadores sí que la requieren. Si no está seguro de 
si su micro necesita o no alimentación fantasma, consulte la documentación 
de su micro o contacte con su fabricante. Este debe estar en OFF si conecta 
fuentes de nivel de línea a las entradas Mic In.

10. TOMAS Headphone 1 Y headphone 2
Conecte aquí unos auriculares con una clavija de 6,3 mm. Estas salidas 
reciben la misma señal que la enviada a las salidas principales, pero disponen 
de sus propios controles de nivel. 
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Conexión del I•ONIX U42S
Micrófonos
Conecte un cable con toma XLR directamente desde el micro a la entrada 
Mic/Inst deseada del panel trasero del U42S.  

Si su micro necesita alimentación fantasma, compruebe primero que 
esté conectado el micro y después, pulse el botón/LED +48V del panel 
trasero para el correspondiente par de entradas. Si sus micros no 
requieren alimentación fantasma, es mejor que la desactive.

Nota: Algunos micros pueden resultar dañados por la alimentación 
fantasma de +48V. Antes de activarla, consulte la documentación de su 
micro.

Fuentes de nivel de línea
Las fuentes de nivel de línea incluyen teclados, cajas de ritmos, reproductores 
de CDs, previos de micro y efectos externos. Conecte un cable con toma de 
6,3 mm TS (no balanceada) o TRS (balanceada) directamente de la fuente 
de nivel de línea a la entrada Mic/Inst deseada del panel trasero del U42S.  

Instrumentos
Las entradas Instrument del panel lateral derecho aceptan señales de 
instrumentos como guitarras eléctricas o bajos. Conecte un cable standard 
con toma no balanceada de 6,3 mm TS (cable de instrumento) directamente 
del instrumento a una de las entradas Instrument del panel lateral derecho 
del U42S.   

Ordenador/DAW
Conecte el puerto USB de su ordenador al puerto USB del panel trasero del 
U42S utilizando un cable USB standard (incluido). 

Auriculares
Conecte los auriculares a la toma(s) Headphone del panel lateral izquierdo. 
Estas tomas aceptan conectores TRS de 6,3 mm. Ajuste el volumen de los 
auriculares con los mandos de nivel Phones 1 o Phones 2.

Monitores
Utilizando cables con clavijas de 6,3 mm, conecte las tomas L/R Main 
Output del panel trasero a las entradas apropiadas de su mezclador, etapa de 
potencia o monitores autoamplificados.
Ajuste el volumen de salida con el mando Output Level. Para un 
resultado óptimo, utilice cables balanceados.
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Ejemplo de conexiones
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Ejemplo de proyecto U42S - Grabación de una 
guitarra 
Para empezar a utilizar el U42S y familiarizarse con él, siga los pasos de este 
ejemplo. En él utilizamos el Cubase® LE 4, pero el U42S también puede 
trabajar con muchas otras aplicaciones DAW.

Instalación de drivers, software de control y Cubase® LE 4
Introduzca el DVD en la unidad DVD-ROM. El instalador arrancará 1.	
de forma automática.  
 
Si no sucede así, puede ejecutarlo manualmente abriendo el 
fichero adecuado del DVD: 
 
Mac®: 		  Open Me 
Windows®: 	 InstallationMenu.exe 

Una vez que arranque el instalador, siga las instrucciones que 2.	
aparecerán en pantalla para instalar el software que quiera utilizar.  
 
Nota: Tiene que instalar los drivers I-ONIX U42S para utilizar el 
U42S con el Cubase® LE 4. También tiene que instalar el Cubase LE 
4 para seguir los pasos del ejemplo de proyecto que aparece en 
las páginas siguientes.  
 
También puede descargar los drivers más recientes desde la 
página web www.lexiconpro.com. 
 

Configuración de audio y MIDI Windows® (opcional)
Una vez que haya instalado los drivers y el software de control, puede 
hacer que Windows los seleccione de forma automática como salidas 
MIDI y de audio por defecto. Esto significa que sus sonidos Windows 
serán enviados al U42S en lugar de a la tarjeta de sonido de su 
ordenador.  Debemos comprobar si han sido modificados y devolver los 
ajustes a los valores anteriores.

Elija 1.	 Inicio>Panel de control>Dispositivos de sonido y audio (XP) o 
Hardware y sonido (Vista).
Elija la pestaña 2.	 Audio (XP) o Administración de dispositivos audio 
(Vista).
En 3.	 Reproducción de sonido>Dispositivo por defecto (XP), o 
Reproducción (Vista), compruebe que esté seleccionada su tarjeta 
de sonido como unidad por defecto.
En 4.	 Grabación de sonido>Dispositivo por defecto (XP), o Grabación 
(Vista), compruebe que esté seleccionada su tarjeta de sonido como 
unidad por defecto.
En 5.	 Reproducción de música MIDI>Dispositivo por defecto, abra el 
menú desplegable y compruebe que esté seleccionada Microsoft GS 
Wavetable Synth como unidad por defecto (solo XP).  
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Proyecto ejemplo - Conexiones
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Conexión de la guitarra
Gire totalmente a izquierda el mando 1.	 Mic/Line/Inst 1.

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Mic/Line/Inst 1 Knob

 
Conecte su guitarra a la entrada Instrument 1 del panel lateral derecho.
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Instrument 1 input
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Conexión de los auriculares
Gire totalmente a la izquierda el mando 2.	 Phones 1.

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Phones 1 Knob

 

Conecte sus auriculares a la toma 3.	 Phones 1 del panel lateral derecho.
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Phones 1 input
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Conexión del ordenador
Conecte el puerto USB de su ordenador al puerto USB del panel trasero 
del I-ONIX U42S utilizando un cable USB standard (incluido). 

 

 

 
 

 

Escucha de la entrada de guitarra (Directa)
1. 	Colóquese los auriculares 
2. 	Ajuste el mando de mezcla de monitor a la posición 12:00. Esto le 

permitirá escuchar una mezcla en la misma proporción de las señales 
enviadas al U42S y de las procedentes del Cubase.

3. 	Toque la guitarra.
4. 	Gire gradualmente el mando Phones 1 hacia la derecha hasta que 

obtenga un nivel de escucha que sea de su agrado.
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Configuración del Cubase® LE 4 para su uso con el 
I•ONIX U42S (Windows®)
1. Asegúrese de que el cable USB incluido esté conectado a su ordenador y al 

U42S y compruebe que el U42S esté encendido. 

2. Ejecute el Cubase® LE 4 (desde el menú Inicio > Lexicon®).

3. Si aparece el mensaje de aviso mostrado abajo, haga clic en OK.

4. Una vez que esté en el Cubase LE 4, vaya a Devices>Device Setup.

5. En Devices, haga clic en VST Audio System y elija Lexicon I-ONIX 
U42s en el menú desplegable de controlador ASIO si no está ya 
seleccionado. Haga clic en Switch para cambiar el driver y después 
haga clic sobre OK en el diálogo Device Setup. Ahora ya estará todo 
listo para empezar a grabar utilizando su U42S y el Cubase LE 4.
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Configuración del Cubase LE 4 para su uso con el 
I•ONIX U42S (Mac®)
1. 	Asegúrese de que el cable USB incluido esté conectado a su ordenador y 

al U42S y compruebe que la aplicación de mezclador esté abierta y que el 
U42S esté encendido. 

2. 	Abra el Cubase LE 4 (en la carpeta Applications) y vaya a  
Devices>Device Setup como puede ver en la imagen de abajo.

3. 	Haga clic en VST Audio System y elija Lexicon I-ONIX U42s como 
driver ASIO si es que no estaba ya seleccionado. 

4.  El Cubase® LE 4 le preguntará ahora si quiere cambiar de driver. Elija 
Switch y después OK.

Solo para usuarios de Mac® OS 10.4.x: Después de seleccionar el Lexicon 
X4 como el driver ASIO, tendrá que comprobar que estén activas las 
entradas de su dispositivo. Para ello, haga lo siguiente:
 

Elija 1.	 Device>VST Connections en la barra de menús.
Cuando aparezca el panel VST Connections, haga clic en la pestaña 2.	 Inputs.
Puede que el recuadro que hay debajo de la columna Audio Device 3.	
indique “Not Connected”. Si ocurre esto, haga clic en este recuadro y 
seleccione Lexicon I-ONIX U42s para activar las entradas del U42S. 
Cierre la ventana VST Connections.4.	

Ahora ya estará todo listo para empezar a grabar con el Cubase LE 4, tal 
y como le indicamos en la siguiente sección,
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Grabación de una pista en Cubase® LE 4

Creación de un nuevo proyecto
En Cubase, haga clic en 1.	 File > New Project. Aparecerá el recuadro de 
diálogo New Project.
Elija 2.	 Lexicon I-ONIX U42S Mono In y haga clic en OK.
Elija una carpeta de proyecto y haga clic en 3.	 Choose.
Añada una pista mono haciendo clic en 4.	 Project -> Add Track -> 
Audio. Elija la configuración Mono y haga clic en OK.
En la ventana 5.	 Audio 1, el botón de activación de grabación  ya 
debería estar en rojo. Si no es así, haga clic sobre él para que se encienda. 

	

	

En la ventana 6.	 Audio 1, haga clic sobre el botón de monitorización de 
entrada  para que no esté encendido. 
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Empiece a grabar
	 Haga clic sobre el botón 1.	 Record del control de transporte del 
Cubase® LE 4. 
 
 
 
 
	

Record Button 
 

	Toque la guitarra. 2.	
	Cuando acabe de grabar, pulse el botón 3.	 Stop.  

		   
 
 
		

Stop Button 

Escucha de la grabación
	En Cubase, haga clic en el botón 1.	 Go to Zero.

		
Go to Zero Button

 

	Gire el mando 2.	 Phones 1 totalmente hacia la izquierda.
	Colóquese los auriculares.3.	
	En Cubase, haga clic sobre el botón 4.	 Play. 

	
		

Play Button

En el U42S, gire gradualmente el botón 5.	 Phones 1 hacia la derecha 
para conseguir un nivel de escucha que le resulte agradable.

Una vez que añada una pista a su proyecto Cubase, el campo Input 
Routing quedará por defecto en U42S In 1. Sin embargo, si conecta 
instrumentos a otras entradas del U42S, necesitará modificar el ruteo 
de entrada para la pista en la que vaya a grabar. Para ver qué etiquetas 
de ruteo de entrada del Cubase LE 4 corresponden a las entradas físicas 
del U42S, vea la siguiente tabla. 
 

Entrada U42S
Etiquetas de ruteo de entrada 
para pistas mono en Cubase 

LE 4 (cuando esté utilizando la 
plantilla de proyecto Lexicon® 

I-ONIX U42S Mono In)

1 U42S In 1

2 U42S In 2

3 U42S In 3

4 U42S In 4
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Remezcla Audio
Puede utilizar la función de remezcla audio en Cubase® LE 4 para crear 
un fichero .wav a partir de su proyecto Cubase, que después podrá grabar 
en un CD o reproducirlo utilizando el reproductor multimedia de su 
ordenador. Sin embargo, el Cubase LE 4 no le permite remezclar el fichero 
en formato mp3; pero, puede utilizar otro programa para convertir un 
fichero .wav en otro en formato mp3. 
 
Para remezclar su proyecto, primero tendrá que colocar los 
localizadores izquierdo y derecho; una forma de hacerlo es pulsar [Ctrl] 
+ [A] en el teclado de su ordenador y después [P].  También puede 
hacer clic y arrastrar cualquiera de los marcadores hasta la posición 
deseada.
 
Una vez que haya ajustado los localizadores, vaya a File > Export > 
Audio mixdown. Haga clic en el botón ‘Choose’ , introduzca el nombre 
del fichero en el campo ‘File name:’, elija en el campo ‘Look in’  la 
ubicación en la que quiera  que sea grabado el fichero .wav y haga 
clic en el botón  ‘Save’.  Debe grabar el fichero en el disco duro de su 
ordenador antes de grabarlo en un CD.  
 
A continuación, elija Wave File (.wav) en el campo ‘File Format’ , ajuste 
‘Sample Rate’ a 44.1 kHz, ‘Bit Depth’ a 16 bits y haga clic en Export.
 
Opciones y funciones en Cubase LE 4
El Cubase LE 4 incluye muchas opciones y funciones avanzadas para grabar, 
editar y mezclar audio. Para más información sobre ellas, vea las secciones 
‘Puesta en marcha’ y ‘Manual de instrucciones’ que encontrará en el Cubase 
LE 4 en Help > Documentation.

Uso del Pantheon II Reverb en Cubase LE 4
Puede configurar la reverb Pantheon en Cubase LE 4 de dos maneras: como 
una inserción en una pista audio o como una inserción en un canal de 
efectos.
 
Para utilizar el Pantheon como una inserción en una pista audio: 

Haga clic en la pestaña 1.	 Inserts para el canal en el que quiera insertar 
la reverb Pantheon II.
Haga clic en una ranura vacía y elija 2.	 Earlier VST Plug-ins > Lexicon 
> Pantheon II. Solo escuchará la reverb Pantheon II en la pista audio 
en la que haya sido insertada.

 
Para utilizar el Pantheon II como una inserción en un canal de efectos:

Añada un canal de efectos. Para ello, vaya a 1.	 Project > Add track > FX 
Channel y haga clic en la pestaña Inserts para el canal de efectos.  
Haga clic en una ranura vacía y elija 2.	 Earlier VST Plug-ins > Lexicon > 
Pantheon II.  
Haga clic en la pestaña 3.	 Sends para las pistas audio a las que quiera 
que les afecte la reverb.
Haga clic en una ranura vacía y ajuste la salida a 4.	 FX-1 Pantheon II.
Haga clic en el botón Power y ajuste el nivel de envío al valor 5.	
deseado. Puede enviar al canal FX la señal de cualquier número de 
pistas audio.
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Especificaciones técnicas

Los técnicos de Lexicon® están tratando constantemente de mejorar la calidad de nuestros 
productos. Por este motivo las especificaciones están sujetas a cambios sin previo aviso.

Entradas de micro:
Impedancia de entrada: 
Alimentación fantasma: 
Ganancia máxima: 
E.I.N. (a ganancia máx.):
	
Nivel máx. de entrada:
Respuesta de frecuencia: 
THD+N: 
		

Entradas de línea: 	
Impedancia de entrada: 	
Nivel máx. de entrada: 	
Respuesta de frecuencia: 	
THD+N: 	
		
Entrada de instrumento: 	
Impedancia de entrada: 	
Nivel máx. de entrada: 	
Respuesta de frecuencia: 	
THD+N: 	

Salidas de línea: 	
Nivel: 	
Impedancia: 	

Salida de auriculares : 	

Interface MIDI: 	
Velocidad de muestreo: 	

Rango dinámico:	
		
		

Alimentación: 	
	

XLR hembra; punta 2 activa
3 kΩ balanceada
+48 Voltios
+58 dB
−126 dBu @ 58 dB ganancia típica (150 Ω fuente)
−129 dBu @ 58dB ganancia típica medición A (150 Ω fuente)
+14 dBu a ganancia mínima
+0/−1 dB, 20 Hz - 20 kHz
<0.02%, 20 Hz - 20 kHz (entrada de micro a salida principal)
<0.015%, 1 kHz, -6 dBu nivel de entrada

 TRS de 6,3 mm balanceadas o no balanceadas
20 kΩ balanceada, 13 kΩ no balanceada
+32 dBu
+0/−1.5 dB, 20 Hz - 20 kHz (referencia 1 kHz)
<0.05%, 20 Hz - 20 kHz (entrada de línea a salida principal)

TS de 6,3 mm no balanceada
1 MΩ
+13 dBu
+0/−2 dB, 20 Hz - 20 kHz (entrada de instrumento a salida principal)
<0.05%, 20 Hz - 20 kHz, +4 dBu

TRS de 6,3 mm balanceadas o no balanceadas
>+18 dBu máximo
32 Ω balanceada, 16 Ω no balanceada

toma stereo de 6,3 mm 350 mW por canal a 50 Ω 

Conectores DIN de 5 puntas para entrada MIDI y salida MIDI (señal 5 voltios)
44.1, 48, 88.2 ó 96 kHz (determinada por el programa de ordenador) 

A/D (24 bita) 108 dB típica, medición A, 20 Hz - 20 kHz 
(velocidad de muestreo 44.1 kHz)
D/A (24 bits) 110 dB típica, medición A, 20 Hz - 20 kHz
A/D/A (24 bits) 102 dB típica, medición A, 20 Hz - 20 kHz

18 W 9 V CA
Adaptadores de corriente disponibles: 
PSS3-120 (EEUU)
PSS3-EU (Europa)
PSS3-UK (Reino Unido)
PSS3-JA (Japón)
PSS3-AU (Australia)
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